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Introduction 
3CR has Cool Edit Pro 2.1 on its computers in Studio 2, Studio 3 and the 
control room. It is an excellent program for digital editing of interviews as a 
single track, and can also be used to produce multi track pieces using a range 
of sound sources. These notes are primarily designed for basic single track 
editing in 3CR studios. 
 
First thing we need to do to be able to work with audio on the computer, is 
to record the piece of sound we want to edit on to the computer. You have 
different options as to where you can access audio to feed in to the 
computer: for example, line in is everything that comes through the panel, 
while CD is the CD drive on the actual computer. You will primarily need to 
use line in which will probably already be selected but if it isn’t YOU will 
need to select it.  
 
Playback levels  
Cool Edit Pro does not automatically control the recording levels or playback 
levels or select the audio feed in to the computer. This is done by you 
setting the levels and making the selections. Most of the time the levels and 
sound sources are already set to a good level and line in is also selected, but 
if they’re not you’ll need to open up the controls and change them.  
 
In the bottom right corner of your desktop you should have a yellow symbol 
for a speaker. Double click on this icon and a mixing panel will be displayed on 
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your screen. The mixing panel on the screen has faders similar to that on a 
real panel. The mixing panel that automatically opens on your screen contains 
the controls only for your playback levels. Here you can select the source of 
what you want to hear played back from the computer.  
 
Any Cool Edit audio files are played through the wave channel and also 
controlled through the play control fader. On the actual studio panel the 
computer comes through the channel labeled PC (Studio 2) or COMP (Studio 
3). 
 
When you open the play controls you do not always see all the channels of 
the Volume Control such as CD Audio, Wave, etc. If you do not see them you 
have to choose Options and Properties and there you can select all the lines 
you would like to have included in the mixing desk.  
 
Recording levels 
To see the panel for recording controls, you need to click on Options, then 
on Properties and select Recording (having first double clicked on the yellow 
speaker icon). A panel with the recording controls will appear on your screen. 
Next you need to select the audio source you want to use, for example line 
in or CD etc. Again, everything that is played through the panel comes 
through the line in. You can select the source you want to record from and 
also move the faders up and down, to increase or decrease the recording 
levels. 
 
In order not to get any feedback when recording you need to mute the line 
in on the play controls when recording on to the computer using the line in 
source. 
 
PLEASE NOTE on 3CR computers with new sound cards the levels are 
set automatically and it is NOT possible to change them 
 
Creating a New File 
Now you can open a new file in Cool Edit Pro. To do this click on File and 
select New. A new screen appears. Within this screen you are asked what 
settings to give to your recording, or in other words, what quality and size 
your new audio piece will be.  
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Most likely the following settings will automatically come up as the last 
selected settings: 
Sample Rate: 44,100 
Channel: Mono 
Resolution: 16 bit 
 
You need to change the settings to the above if they do not come up 
automatically. However, here is some information for your general interest. 
 
Sample Rate 
The sample rate indicates how many times a sample of sound is taken over a 
specific time. For CD quality the sound card will take 44,100 samples per 
second.  
 
8,000 Hz Telephone Quality 
11,025 Hz Poor AM Radio Quality 
16,000 Hz Reasonable compromise between 11 KHz and 22 KHz 
22,050 Hz Near FM Radio Quality 
32,075 Hz Better than FM Radio Quality  
44,100 Hz CD Quality 
48,000 Hz DAT Quality 
 
Channels 
Mono wave forms support one channel of information. Stereo files take twice 
the space because there are two channels of information represented. As 
3CR broadcasts in mono it is adequate to record in mono. If you are creating 
a CD it is then best to record in stereo. 
 
Resolution 
This describes the number of bits to use for each sample on each channel. 
As an example, compact disc players have a 16-bit resolution.  
 
When you have selected these options, click OK and you are ready to record. 
 
Monitoring the Recording Levels 
As you would do with any piece of equipment you use to record - minidisk or 
cassette - you need to check first your recording levels to make sure that 
your audio is loud enough, but not too loud and therefore distorted. There is 
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nothing worse than having recorded a really good interview and when you go 
to play it back it is either too low or is distorted from being too loud. This is 
a good habit you will have to learn. Most recording equipment will have 
different ways of monitoring and controlling the sound. You should check 
your recording levels each time you want to record something onto your 
minidisk or onto Cool Edit Pro. 
 
To monitor the volume of your sound you need to see it. Click on Options and 
then on Monitor Record Level. It will activate the VU meter which is a unit 
that visually shows the level of the volume. If you continually talk into your 
microphone, or play another sound source through the panel, you can see the 
levels on the VU meter moving. 
 
It is the red line (one if you are recording in mono and two if you do it in 
stereo) from the left to the right following the changes of your voice or 
sound source: the further right it goes the louder you are recording. 
 
Suggested Recording Levels 
Cool Edit Pro 2.1 suggests you should record as loud as possible without 
clipping. Clipping is when you record too loud. It shows up in red on your VU 
meter on the right hand side of the 0db. If you record too loud your sound 
will be distorted. The maximum level that you can record to before 
distortion is 0db. The best would be recording to a maximum level of –4 or 
preferably -6. At this level you allow yourself room to go slightly over but 
still not to peak and cause distortion. You cannot control the recording level 
from the Cool Edit programme. You need to go to the Recording Control 
mixing desk and slide the fader up or down to adjust the recording volume 
(as outlined above). 
 
Wave files 
Now everything is ready to record. Just one hint before pressing the red 
recording button: if you wish to see how your audio appears in the form of a 
wave in the screen while it is being recorded, you have to click Options, 
Settings and then select Live update during record. It is likely that this 
has already been selected. When you begin to record you can see the wave 
appearing on the Cool Edit Pro screen. Use the control buttons in the left 
hand side at the bottom of the screen. They work as in any other sound 
device.  
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Just click on the Record button and speak or start your sound source 
playing. 
 
When you have finished click on the Stop button. Your voice or sound source 
is now represented on the screen by a wave. The next job is to save. It is 
very important to save as frequently as possible when using Cool Edit Pro or 
any digital editing package. To save your recording click on File, scroll to and 
click on Save As ... It’s best to create yourself a folder to store all your 
audio files. This should be done on the Main Data D: drive in Studio 3 and 
the Main C: drive in Studio 2. But remember! 3CR computers have limited 
space and are regularly cleared so don’t store too much on the computer and 
save completed pieces to CD for archiving (see below). 
 
Listening to a wave 
You probably want to listen to what you have recorded. If you want to hear 
what you have recorded you need to slide up the fader of the Wave channel 
in the Playback Controls – it is likely that this is already set up correctly. If 
not you’ll need to change them (refer above, Playback Levels). If you fade 
down or mute the rest of the channels you will be able to hear the sound 
coming from the Wave channel even better.  
 
Now click on Play in the control buttons of Cool Edit Pro. 
 
The wave forms 
By listening and looking at different waves carefully you will learn a lot about 
how the sound is represented on the screen. The first thing to notice is that 
that when the recording is too loud and therefore distorted the top and 
bottom edges are unnaturally flat, as if they were cut with scissors. There is 
no way to fix this and it should be avoided at all costs. When the recording 
is too soft it is represented by a small wave in the center of the screen. 
This can be corrected (see below) but is not ideal. Over time you will also 
learn to recognize certain words, ummms and silence just by looking at the 
wave. 
                                                                                                                                    
Basic Editing 
Now that we have some audio files or waves stored on our computer we can 
start learning the basics of digital sound editing. The main functions you will 
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use for most of your editing are Cut, Copy and Paste. You will find these by 
clicking on Edit and scrolling down to the one you want and clicking on it. You 
can also do it more directly with the buttons of the tool bar at the top of 
the screen.  
 
The Undo option 
Before you start editing it is very important that you have activated the 
option Undo. It means that every time you edit something, if you are not 
happy with the result you have the option of deleting your last action. So you 
can feel more relaxed about cutting parts of your wave if you know that you 
can still change your mind and recover the wave like it was before your last 
step or cut. You can go back undoing the actions you have made up to 80 
times. To make sure this option is activated go to the Edit menu and select 
Enable Undo. Every time you want to undo your last move you go to Undo in 
the Edit menu or to the corresponding icon in the tool bar. 
 
Making selections, cutting and pasting 
While listening to a wave you must have noticed the yellow line that moves 
across your screen. If not, play your wave again and look carefully at the 
screen. This line is very important; it will mark your editing points. 
 
Play the wave a few times to become familiar with the shapes and how they 
represent sounds. You can use the space bar on your keyboard to start and 
stop playing. Play the wave and pause the yellow line just at the beginning of 
the words you are going to delete. Click on the point of the wave where you 
want your selection to begin. Hold down the left button of the mouse 
dragging the mouse to the right until you reach the end of the words you are 
selecting - just as you do in any other Windows application. You can also do 
this in reverse if you want, that is, last words until first ones. When you 
release the button, the area you have selected is highlighted. To listen and 
check your selection, click on Play. It will only play the selected part of the 
wave. 
 
If you want to make the same selection bigger or smaller to be more 
precise, you can click on either of the small yellow triangles at the two top 
corners of your highlighted selection – a hand will appear and you can drag to 
the left or right to increase or decrease your selection. You can modify the 
selection and play it as many times as you want until you are sure the correct 
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words and only the words are included in the selection. To erase the 
selection go to Edit, scroll to and click on Delete Selection, or simply press 
delete on your keyboard. Your selection has now been erased. Click on Play to 
listen. If you are not satisfied with the result remember you can always use 
Undo. Undo is the first option in the Edit menu! 
 
The next step will be moving a selection to its correct place. Select some 
words you’d like to move. We will cut them from where they are and paste 
them in the right place. When you are satisfied with your selection choose 
Cut in the Edit menu. The selection has now gone from your recording but is 
stored to the clipboard in the computer waiting for you to paste it 
somewhere else. You need to find the exact point of the wave where you 
want to insert it. (Note that there are keyboard short cuts for cutting 
and pasting just as in Windows). Once you are sure you have found the 
point where your selection belongs, select Paste in the Edit menu.  
 
The shape of your selection now appears again on the screen but in its new 
place. Listen to the result and decide if you are happy with it. When you 
have made your changes don’t forget to save.  
 
Using zoom and timer 
As you may have seen the waves stretch and shrink to fit in the screen. It is 
not the same to have a few seconds or a 30 minutes wave on the screen. In 
the 30 minutes one the wave is tight in a small space. Like this it is difficult 
to make precise selections. However, we can change the view of the wave 
(bigger and smaller) to recognise the parts we want to select.  
 
To do that we use the Zoom options. The most useful ones are the three at 
the top and the one in the left bottom corner of the Zoom menu. Here is an 
explanation of how these options work: 
Zoom to centre: It stretches the wave. However, to show a wave in more 
detail means that not all of it is shown on the screen, but just a part of it. 
This button enlarges the whole wave but shows just a part in the centre of 
the wave. If you want to see a part that is not shown on the screen you can 
move along the wave using the green bar at the top of the screen just under 
the toolbar. 
Zoom out: This option does the opposite. It makes the wave smaller or it 
shrinks it and therefore shows all or more of it on the screen. 
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Zoom out full: This option goes back to the original size showing the whole 
wave fitting in the screen. 
Zoom to selection: It shows the whole of a selection fitting in the screen. 
The bar at the top of the screen just under the tool bar shows the part you 
are viewing in the screen in proportion to the whole wave. The green part is 
the part you are viewing. If the whole bar is in green it means that you are 
seeing the whole wave. You can move along the wave when it is zoomed. If 
you point your cursor on the green bar it becomes a hand. If you hold the 
left button of the mouse and drag it you can move through the wave right 
and left. Now try to click the right button of your mouse when your cursor is 
on the green bar. Dragging it you can make the area of the wave that you are 
viewing bigger or smaller to your wish. 
 
The timer 
This is another useful tool to help you editing. The timer is a clock that 
shows the length of your audio works. By default it shows the time in decimal 
format - minutes, seconds and milliseconds (mm:ss.dd). You can choose what 
format you like at Display, Time Format in the View menu. The time that 
appears at the left shows the length of the track until the particular point 
of the yellow line in the wave. The table at the right side shows the 
beginning, end and total length of the selection (the upper file) and of the 
whole wave (bottom file).  
 
You can use the timer as a control to adjust your selection or your piece to a 
particular length of time or to be very precise when choosing the point 
where you start cutting, pasting or whatever editing you want to do. 
 
Transforming waves 
Cool Edit Pro allows you to transform the wave in different ways, reducing 
noise, amplifying or creating effects with the voice or music you have 
previously recorded. This can be very useful, e.g. when you have recorded an 
interview too low in volume.  
 
These notes will not go very deeply into the possibilities of these options. 
There will be just two examples, so as to give you an idea of what the 
possibilities are. You can experiment and learn about it yourself.  
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To transform we first need to open a wave. Choose one with a voice. Go to 
the menu Effects and choose Amplitude. You will see different options. We 
are just using the Amplify option. If you click on Amplify you will see a 
window where you can choose two ways of setting the level of amplification: 
- Manually, sliding the fader right and left to the percentage you wish. 
- Using the presets that appear in the right hand of the screen. You can 
choose Boost or Cut, and in what level. 
 
The best way to learn about the effects is trying them. If you press Preview 
you can pre-hear the result without actually modifying the wave. You can also 
press OK and see how the wave transforms graphically. Remember that you 
can always Undo the amplification if you don't like the result. The Amplify 
option is used to adjust the sound of your waves to a certain level (lower or 
higher than your original recording). This tool is quite useful if you want to 
make sure that different waves you have recorded all have the same volume. 
By selected a section you can also use the fade in and fade out tools which 
can also be useful. Try them. Now try the effects. There are a lot of 
different effects to modify the sound in Cool Edit Pro.  
 
Open Delay Effects in the Transform menu and a list is displayed: Chorus, 
Delay, Echo, Flanger, Reverb etc. Choose one of them, for instance Chorus. 
As with the Amplify option you can work manually or with the pre-sets. As 
we are just starting to use these options it is easier to play around with the 
pre-sets to become more familiar with the effects and what can be done 
with them. The great thing here is that you can select any option and 
preview to hear what it sounds like. If you do not like it, try another one. 
Each of the Delay Effects options has a list of pre-sets. 
 
Transferring Your Audio File to Another Source 
Once you have completed editing your audio file and done a final save you will 
need to transfer it to a tape, mini-disc or CD in order to play it on air. Also, 
as there is limited space on the 3CR computers it is important that you 
regularly clear your folder of audio files – otherwise they may be deleted 
for you! (Regular clearing of audio files currently happens on the first 
Monday of the month). 
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Burning to CD 
You may wish to do this by burning files to a CD. You can save either audio or 
data files on CD. Audio files can be played on any CD player while data files 
must be opened on a computer that has Cool Edit Pro 2.1 on it.  
 
Close Cool Edit and any other programs and return to the desktop. Double 
click on the Expressburn icon. Choose your recording options – music for a 
simple audio file or data for data files. On the hard drive find your 
audio/wave file. Left click on it and drag it down to the space below. Here 
your audio file will be listed as a track with details of length, name etc. Once 
you have selected all your audio files you can click on the Record icon. Follow 
the pre-sets to start recording. 
 
Recording back to tape, mini-disc, cassette etc. 
Alternatively, you may wish to record to reel to reel tape, mini-disc or 
cassette. Simply play your audio file through the panel (channel labelled PC 
or COMP) and set up your tape, mini-disc or cassette to record. Set the 
levels correctly on the panel and then check them on the recording machine. 
Remember, if nothing is coming through or the levels are incorrect you 
should also set them through the Play Levels on the computer with the 
Wave channel (see above).  
 
Deleting Your Audio Files off the Computer 
Once you have copied your files off the computer you should go back and 
delete it off the hard drive. Close all programs on the computer and return 
to the desktop. Double click on the My Computer icon and locate your file on 
either C or D drive. Select both the wav. file and the pk. file and delete 
them.  
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